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Introduction
Welcome to FirstClass, SoftArc’s electronic mail, conferencing, and on-
line system. This guide will help you install the FirstClass Client 
software on your Macintosh and then show you how to connect to a 
FirstClass server and start using all of the great features FirstClass 
offers.

FirstClass is an advanced conferencing, electronic mail, bulletin board, 
and online communication system that combines superb 
communications with a graphical user interface. When using FirstClass,
the graphical user interface makes sending messages and transferring 
files easy and quick. In addition, the same interface takes care of all 
modem and file transfer protocols automatically, so remote access is 
just as easy as network access.

With FirstClass you can...

Exchange electronic mail with other users.

Exchange mail with users on other systems such 
as the Internet.

Transfer any number of files quickly using file 
attachments.

Engage in electronic conferencing with other 
users on a variety of topics.

Dial in using a modem while retaining the full 
graphical interface of your Macintosh.

Engage in a chat with other users online.
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FirstClass was designed for computers with a graphical user interface. 
This means that you can find what you are interested in quickly, without
sifting through reams of unwanted information. You can point and click 
to read a particular message or open a conference without having to 
sort manually through all the messages on a particular topic.

Nothing in FirstClass forces you to wait; you can read a message in one
window, browse a conference in another, compose a memo in a third, 
and chat with another user in yet another window, all while transferring
files in the background. FirstClass provides the ideal environment for 
online electronic communications.

The Server and the Client
FirstClass actually consists of two pieces of software: The FirstClass 
Server and the FirstClass Client. The Server is run by your
Administrator; you will be running the FirstClass Client application in 
order to access the services provided by the FirstClass Server. Note 
that the FirstClass Client requires a FirstClass Server to connect to. 
You cannot use any of the features of FirstClass unless you are actually 
connected to a FirstClass Server. The client may be connected to the 
server using a number of communication systems, including modems, 
AppleTalk and Ethernet.

Since this manual is for the FirstClass Client software, when we say 
“FirstClass” in the manual we will mean the FirstClass Client.

Before You Start
You should have some familiarity with the Macintosh graphical user 
interface before using FirstClass. You should understand terms such as 
mouse, drag, open, select, file, choose, alias and double-click. For more 
information, refer to the manuals that came with your Macintosh.
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How to use this Guide
This guide is designed to get you up and running quickly. It covers the 
installation and basic operation of FirstClass. If you have already used 
FirstClass, or you are an experienced Macintosh user, much of 
FirstClass will be familiar.

Documentation Conventions
Throughout this document, there are several conventions that you 
should be aware of: The names of application programs will be referred
to using italics, e.g. the FirstClass Client 2.5 application. Folders and 
conferences are referred to using quotations, e.g. the “FirstClass 
Client” folder or the “News” conference. Entries on forms are referred 
to as fields or boxes and are denoted using the Geneva italic type face, 
e.g. the Server name field on the Communication Setup Form. Buttons 
and menu items are referred to in italics, e.g. the File menu, the Setup 
button.

Finally, some information in this manual appears in more than one 
place. In this case, there will be a note referring you to the other 
section, and the reference will be denoted by the chevron character (»).

Support
Your Administrator should be able to solve any problems you encounter.
Once you have installed FirstClass and have connected to the server, 
you may use the mail system to request assistance or report any 
problems by addressing messages to the Administrator. If you are 
unable to install FirstClass, you will have to use another method (e.g. 
phone, fax) to contact your Administrator.
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In addition, SoftArc Inc. runs its own FirstClass system, SoftArc Online,
for customer support. The system is available twenty-four hours a day 
for any user to log in to and auto-register. Our conferences answer 
commonly asked questions and contain many hints and tips from 
experienced FirstClass users. The number for SoftArc Online is (416) 
609-2250. You can log in as User ID “guest” with no password if you 
would like to try out the system or ask questions in public areas. Auto-
registration is available so you can log in as yourself using your favorite
User ID and password if you plan to call more than once.

We also provide support through several other electronic mail systems:

Internet
You may contact us as support@softarc.com or sales@softarc.com. 
We also have our own newsgroup, alt.bbs.first-class.

America Online
Our account is SOFTARC. We monitor America Online and also 
provide support through the Communications And Networking area.

Compuserve
Our account is 70511,2023. We also monitor MACCOMM and 
IBMBBS.

AppleLink
CDA0674
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Installing FirstClass
The first step in using FirstClass is to install the software onto your 
Macintosh or Power Mac. FirstClass may be installed on almost any 
Macintosh or Power Mac. The requirements are:

• A Macintosh Plus or newer Macintosh computer, or any Power Mac 
computer

• System Software 6.0.3 or later
FirstClass is fully System 7 compatible.

• At least 1 megabyte of free storage on your hard disk.
To check this, open any folder on your Macintosh and choose By 
Icon from the View menu. The amount of available storage is shown 
in the upper right corner of the folder (in this example, 2 
Megabytes):

• 600K or more of free memory after starting your Macintosh.
(To check this, choose About This Macintosh... from the Apple 
menu. The free memory is displayed in the Largest Unused Block field 
(in this example, 1,221K):
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Installing FirstClass from Diskette
If you have received a FirstClass Client 2.5 diskette, simply insert the 
diskette into your Macintosh and drag the “FirstClass Client 2.5” folder
to your hard disk. This will create a copy of the “FirstClass Client 2.5” 
folder on your hard disk. The “FirstClass Client” folder contains all of 
the files required by FirstClass:
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Installing FirstClass from Archive
If you have downloaded the FirstClass Client 2.5 as an archive (e.g. 
“FirstClass® Client 2.5.sea”), simply double-click on the archive and 
choose the hard disk where you want FirstClass installed:

 

This will install the “FirstClass® Client 2.5” folder on your hard disk. 
The “FirstClass Client” folder contains all of the files required by 
FirstClass. The folder may include a “Read Me file”, which will include 
installation notices and late breaking news. Please read this file (if it 
exists).
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Overview of  FirstClass

In order to use any of the features of FirstClass, you must make a 
connection from your Macintosh to the FirstClass server, and then you 
must supply your User ID and password before the server will let you 
on. This process is known as logging in. 

Settings Documents
Typically, every FirstClass system you will connect to has a Settings 
Document. A Settings Document contains all of the information 
required for FirstClass to connect to a server. For example, if the 
connection will be made via modem the Settings Document will 
typically contain the phone number of the system. If the connection is 
to be made over a Local Area Network, the Settings Document typically
contains the server name and zone. The Settings Document may also 
contain additional custom items such as forms, icons, sounds and 
pictures.

Usually, your Administrator will have provided a Settings Document for 
you to use when connecting to the FirstClass Server. To find the 
Settings Document, simply open the “Settings” folder, stored in the 
“FirstClass Client” folder:
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If there is not a Settings Document for the system you want to connect 
to, you may create new Settings Documents, although they will lack any
custom forms, etc. To create a new Settings Document, simply 
duplicate the “Generic Network” or “Generic Modem” Settings 
Document and rename it as required. To duplicate a file, click on it and 
then choose Duplicate from the File menu in the Macintosh Finder.

Starting the FirstClass Application
To start the FirstClass Client application, open a Settings Document by 
double-clicking on it. As soon as FirstClass starts up, the Login Form is 
displayed:

 

From here, you login, or connect, to the FirstClass Server. The Login 
Form has the following controls:
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User ID
Each user has a unique and private User ID. You should type 
your User ID into this box. If you do not have a User ID, you 
should check with your System Administrator. 
» The User ID is not normally saved. By using the Setup button, 
you may also store your User ID in the Settings Document for 
convenience. 
» Your Administrator may have enabled the Auto-register 
feature, which will allow you to log in with any User ID.

Password
Each user has a unique and private password. You should type 
your password into this box. If you have forgotten your 
password, you should check with your System Administrator. 
» The Password is not normally saved. By using the Setup button,
you may also store your Password in the Settings Document for 
convenience. 
» Once you have logged on you may change your password by 
choosing Change Password from the Service menu.

Service
This field shows you the name of the Settings Document you 
have open.

Setup button
Clicking on the Setup button opens the Settings Form and allows
you to change the entries that are saved in the Settings 
Document.

Cancel button
Clicking on the Cancel button will close the Login Form.

Login button
Clicking on the Login button will instruct FirstClass to start a 
connection to the FirstClass Server, using the current settings.

In this example, we have entered the User ID and password into the 
appropriate boxes.
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Using FirstClass With Modems

If you will be using a modem with FirstClass to connect to an online 
system, you should read this chapter. If you will not be using modem 
connections you may skip this chapter

Before you start using FirstClass with a modem, you should ensure that
you have set up FirstClass and your Macintosh so that they will work 
together correctly with your particular modem. To do this, you must 
configure the Modem Connection File. Follow these steps (in this 
example, we will configure FirstClass to work with a Hayes Ultra 14.4 
modem):
» For details on Connection Files, see Appendix A.

1) Ensure that you have connected your modem to your Macintosh 
as specified in the modem documentation. You should use the 
cable supplied with your modem or a SoftArc Hardware 
Handshaking Cable. Do not use a generic modem cable, as most
Macintosh modem cables are not wired correctly.

2) Double-click on the FirstClass Client application. A dialog box 
will appear asking you to select a Settings Document. Click on 
the Cancel button:
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3) Choose Modem from the Connection Setup sub-menu in the 
Service menu:

 

4) The Connection Setup Form for the Modem Connection File will 
be displayed:
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5) Use the Modem popup to select the type of modem that you have.
In this example, we’ll choose Hayes Ultra. If your modem does not
appear in the popup, you should select Hayes 2400, Hayes 9600, or
Hayes 14400, depending on the speed of your modem.

6) If you have the modem connected to the Modem port on your 
Macintosh, set the Port popup to Modem Port. If you have the 
modem connected to the Printer port set the Port popup to Printer
Port. 

7) Set the Phone popup based on the type of phone line that you 
have (Pulse if you have dial phones, Tone if you have Touch Tone 
phones).

8) If you have an approved Hardware Handshaking Cable, you may 
turn the H/W Handshake and DTR Hangup popups to On. If you do 
not have an approved Hardware Handshaking Cable, you 
should leave these turned Off.

9) The Auto Speed and Baud Rate popups are set automatically when 
you select a modem. You should not change these popups.

10) Click on the Save button. This will save your settings into the 
Modem Connection File.

Once you have set up the Modem Connection File as described above, 
FirstClass will automatically use your settings when you set the Connect
via popup in the Settings Form to Modem. You do not need to change the
Modem Connection File unless you change your modem setup.

» If you want additional information about the Connection Setup Form, 
see Chapter 10.
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Checking The Settings Document
The first time you use a Settings Document you should ensure that all 
of the settings are correct. By clicking on the Setup button on the Login
Form or by choosing Setup... from the Service menu the Settings Form 
is displayed:

 

The Settings Form will have the name of the Settings Document 
displayed in the title, and will also contain the following controls:

Connect via
The Connect via popup allows you to choose which connection 
method you will use to connect to the server. For a modem 
connection you should choose Modem. This will select the
Modem Connection File that you have already configured.
» For details on additional choices, see the Connection Setup 
Form section.
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Setup button
Clicking on the Setup button will display the Connection Setup 
Form for the connection type selected in the Connect Via popup. 
» For details, see the Connection Setup Form section.

User ID
You may enter your User ID here to have it automatically stored 
in the Settings Document.

Password
You may enter your password here to have it automatically 
stored in the Settings Document.

Note: If other people have access to your computer, you 
may prefer not to save your UserID or Password for 
security reasons. If you choose not to save this 
information, you can simply type them into the box on
the Login Form every time you open the Settings 
Document.

Logon Automatically
If this is checked, FirstClass will automatically log on as soon as 
the Settings Document is opened. You may disable the automatic
logon by holding down the Option key when you open a Settings 
Document.

Retry, Retry Delay
If you will be connecting via modem and you receive frequent 
busy signals, you may configure FirstClass to retry 
automatically. The Retry box controls the number of retries, the 
Retry Delay box controls the delay between retries.

Server, Network
Not used for modem connections.
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Phone Number
If you will be connecting to the server over a modem, you should
enter the server phone number in this box. If you are connected 
to an office phone system, you may have to enter a “9” (or other 
special dialing prefix) followed by a comma to dial out correctly.

Cancel button
Clicking on the Cancel button will close the form and discard all 
changes you have made to the Settings Document.

Save button
Clicking on the Save button will close the form and save all of 
the changes that you have made into the current Settings 
Document.

Logging In To FirstClass Using a Modem
Once you have started the FirstClass application by double-clicking on 
a Settings Document and checked that the Settings Document is 
correct, you still have to connect, or log in, to the FirstClass server. To 
do this, click on the Login button. FirstClass will use the connection 
information stored in the Settings Document to connect to the server.

The steps required for FirstClass to connect to a server using a modem 
are complex, but since FirstClass takes care of automating the steps 
the login process is straight forward. As each step of the process is 
performed, you will be informed by the two status lines on the Login 
Form. The first line shows the action in progress, and the second line 
shows the commands sent to the modem and the responses from the 
modem.
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FirstClass performs the login by sending commands to the modem. 
After each command, FirstClass waits for an “OK” response from the 
modem before proceeding. When you click on the Login button, the 
following actions occur (note that if any step fails, the entire login will 
be stopped):

1) FirstClass uses the specified serial port (Modem or Printer) to 
try and reset the modem. It sends the modem reset command 
and waits for an “OK” response from the modem.
Status Line display: “Resetting modem” followed by the reset 
command sent to the modem.

4) If the modem is reset correctly in step 1, FirstClass then sends 
the setup command to the modem. Since each modem requires a
different setup, it is important that you have set the modem type
correctly on the Modem Connection Setup Form (described at 
the beginning of this chapter).
Status line display: “Setting up modem” followed by the setup 
command sent to the modem.

5) Once the modem has been set up, FirstClass sends additional 
commands to configure the modem options (e.g. speaker on or 
off, etc.).
Status line display: “Sending modem options” followed by the 
options command sent to the modem
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6) FirstClass then tells the modem to dial the number stored in the 
Settings Document. You should ensure that the number 
displayed in the status line is correct.
Status line display: “Dialing the number” followed by the dialing
command sent to the modem.

6) While the modem is dialing, FirstClass waits from a “CONNECT”
response from the modem.
Status line display: “Waiting for connection” followed by the 
dialing command sent to the modem.

Once the modem has started dialing, there are a number of possible 
outcomes:

1) If everything is successful, the server will answer the call and 
the two modems will connect. In this case the status line will 
display the message “Negotiating connection” and then the 
“Connected” message. At this point the User ID and password 
you specified will be sent to the server. If your User ID and 
password are correct, your FirstClass Desktop will be displayed.

2) If the server modems are all busy, the modem will report 
“BUSY” and the status line will display “Line is busy” and the 
login will fail.

3) If the modems are unable to connect for any reason, your 
modem will report “NO CARRIER” and the login will fail.

If the connection fails for any other reason, contact your Administrator 
or Technical Support.
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Using FirstClass With Networks

If you will be using an AppleTalk network to connect to the FirstClass 
server you should read this chapter. If you will not be using AppleTalk 
network connections you may skip this section.

Before you start using FirstClass to connect to a server over an 
AppleTalk network, you should ensure that you have set up FirstClass 
and your Macintosh so that they will work together correctly. If you will
be using an AppleTalk network to connect to your server, you should 
ensure that your Macintosh is connected to the AppleTalk network and 
that AppleTalk is turned on. To check this, open the Chooser (in the 
Apple menu). Ensure that the Active button is pressed:
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The Settings Form
The first time you use a Settings Document you should ensure that all 
of the settings are correct. By clicking on the Setup button on the Login
Form or by choosing Setup... from the Service menu the Settings Form 
is displayed:

 

The Settings Form will have the name of the Settings Document 
displayed in the title, and will also contain the following controls:

Connect Via
The Connect Via popup allows you to choose which connection 
method you will use to connect to the server. For an AppleTalk 
connection you should choose AppleTalk. This will select the 
AppleTalk Connection File.
» For details on additional choices, see the Connection Setup 
Form section.
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Setup button
Clicking on the Setup button will display the Connection Setup 
Form for the connection type selected in the Connect Via popup. 
» For details, see the Connection Setup Form section.

User ID
You may enter your User ID here to have it automatically stored 
in the Settings Document.

Password
You may enter your password here to have it automatically 
stored in the Settings Document.

Note: If other people have access to your computer, you 
may prefer not to save your UserID or Password for 
security reasons. If you choose not to save this 
information, you can simply type them into the box on
the Login Form every time you open the Settings 
Document.

Logon Automatically
If this is checked, FirstClass will automatically log on as soon as 
the Settings Document is opened. You may disable the automatic
logon by holding down the Option key when you open a Settings 
Document.

Retry, Retry Delay
Not required for AppleTalk connections.

Server, Network
Enter the server name in the Server box and the server zone in 
the Network box. You may specify * in the zone if the server is in 
your own zone. See your Administrator if you have any 
questions.

Phone Number
Not used for AppleTalk connections.
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Cancel button
Clicking on the Cancel button will close the form and discard all 
changes you have made to the Settings Document.

Save button
Clicking on the Save button will close the form and save all of 
the changes that you have made into the current Settings 
Document.

Logging In to a FirstClass Server
Once you have started the FirstClass application by double-clicking on 
a Settings Document and ensured that your User ID and Password are 
entered in the appropriate boxes, you still have to connect, or log in, to 
the FirstClass server. To do this, click on the Login button. FirstClass 
will use the connection information stored in the Settings Document to 
connect to the server. After a brief negotiation your FirstClass Desktop 
will be displayed.

If you receive error 1044 (“There is no FirstClass server with that name
on the network”), then you will have to ensure that the server Name 
and network Zone settings are set correctly. If the Name and Zone are 
set correctly, or if you receive any other error, contact your 
Administrator to ensure that the server is running and that you have 
proper access to the AppleTalk network.
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FirstClass Basics

This chapter describes the FirstClass Desktop and the basic operation 
of the FirstClass system. The operation of FirstClass is the same 
whether you have connected by modem or network. Once the login has 
completed, your FirstClass Desktop will be displayed. The standard 
FirstClass desktop looks like this, although your Administrator might 
have customized it:

The Desktop window is always displayed while you are connected to the
FirstClass Server. The following important icons are displayed on your 
desktop:

Mailbox: Your Mailbox is where all of your 
incoming and outgoing messages are stored. 
» For details on sending and receiving mail see 
the Using Electronic Mail section. 

News: The “News” conference is a public area 
that everyone on FirstClass has access to.. 
» For details on using “News” and other 
conferences, see the Using Conferences section.

Conferences: The “Conferences” folder usually 
contains all of the conferences that you have 
access to. Your Administrator may set up a 
variety of public and private conferences.

Help: The “Help” folder contains a complete 
online help system that will give you more 
information about the FirstClass system you are 
connected to.
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Each of these icons represents a folder or conference, which in turn 
may contain additional files, folders, conferences and messages. To 
open an icon, simply double-click on it (or click once and choose Open 
from the File menu).

Mailbox, Conference & Folder Windows
When you open any item in FirstClass, it is displayed in a new window. 
When you open a Mailbox, conference or folder icon, the window will 
look similar to this:

FirstClass Client for Macintosh - Getting Started



The window is divided into two panes. The upper pane contains 
additional folders and conferences, while the lower pane contains files. 
Each pane may be scrolled using the scroll bar. To move the split bar, 
position the mouse over the bar and drag when the cursor changes to a 
cross like this:

Message Windows
When you open any message it is displayed in a new window similar to 
this:

The window is divided into two panes. The upper pane contains 
envelope information, while the lower pane contains the body of the 
message. You may scroll and move the split bar as with other windows.

If you resize the message window, the next message you read will be 
opened in a window of the new size.
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Unread Flags
To help you keep track of what you have read, FirstClass will display a 
small flag (like this  ) beside any conference that contains items that 
you have not read. In the example Desktop above, both the Mailbox and
the “News” conference contain items that you have not read. Once you 
have read all items in a conference or your Mailbox, the Unread Flag 
will be turned off. You may also turn off a flag by option-clicking on it.

Palette
FirstClass provides a Command Palette for quick and easy access to 
many FirstClass commands. To display the Command Palette, choose 
Palette from the View menu.

Send messageReply to messageDelete Open next unreadOpen next in threadOpen nextDisplay message historyFind next New messageForward messageDirectory Open previous unreadOpen previous in threadOpen previousAttach fileFind 
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Using Electronic Mail
The FirstClass electronic mail system allows you to send messages to 
any other users on FirstClass.

Reading Your Mail
When you open your Mailbox by double-clicking on the mailbox icon on 
your desktop, a message summary is displayed. Remember, you know 
immediately if you have new unread messages because an Unread Flag 
will be displayed beside the Mailbox icon.

Your mailbox contains a summary of both your incoming and outgoing 
private messages. A busy mailbox might look like this: 

The summary lists the sender or recipient of the message, the size, the 
subject, and the date the message was sent or received.
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The following indicators are used to draw attention to certain 
messages:

A solid flag indicates that the message is unread, meaning that you
have not yet opened this message.

A hollow flag indicates that the message is unsent, meaning that 
you have created the message, but not yet sent it.

A file icon indicates that the message has one or more files 
attached to it. » See the chapter on attachments for more details.

bold Bold type indicates that the message is urgent.

To open any message, simply double-click on it. The message is 
displayed in a new window. To close the message window, click on its 
close box in the upper left corner.

Opening the Next Unread Message
Usually, you will want to read all of your unread messages. To make this
more convenient, FirstClass provides a shortcut to do this: simply open 
your Mailbox and then choose Open Unread from the Conference menu.
FirstClass will open the next unread message in your Mailbox. 
Continuing to choose Open Unread will read all unread messages. 
When there are no more unread messages, FirstClass will beep to 
inform you.

Since this is a common operation, you might also find it convenient to 
use either the keyboard equivalent (Command-U) or the palette button: 
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Creating New Messages
In addition to reading mail sent to you, you may also compose and send 
your own messages. Follow these steps:

1) Choose Compose from the Message menu. A new, unsent 
message is created in your Mailbox and a message window is 
opened. Note that your name is automatically entered in the 
From field:

2) Type a subject for the message and press enter. The cursor 
moves to the To field, ready for you to address the message.

3) Type the name of the person you are sending the message to 
into the To field. When you press enter or tab, FirstClass 
searches for the name in its Directory.

You can enter a complete name such as “Sue Bram”; a last name
only, such as “Chun”; or even a first name, like “Bill”. If only a 
single matching name is found in the Directory, the full name 
replaces whatever you have typed.
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If more than one name is found, FirstClass displays a list of all the 
names that match:

 

To choose a name from the list and enter it into the address list, 
scroll through the list until you see the name you want, click on 
it and then click on the Select button. You may also select one or
more names then click on the Select button, or use the arrow 
keys and press Return when the name you want is highlighted. 
As a shortcut you may double-click on a name to enter it in one 
step. 
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Note: After you’ve entered a name, pressing the enter key creates a 
new line for entry of another name. Pressing the tab or down 
arrow key will position you at the next field without creating 
space for another name.

4) Enter names in the Cc: field if you wish to send copies of the 
message to additional users.

Editing Messages
Once you have created a new message and addressed it, you must 
enter the body by clicking in the bottom pane of the message and 
typing. This will use the FirstClass Editor. The FirstClass Editor 
provides a full-screen WYSIWYG (what-you-see-is-what-you-get) 
interface that supports all the standard editor functions (Cut, Copy, 
Clear, Paste). Double-clicking in the editor will select a word; triple-
clicking will select a paragraph. Choosing Select All from the Edit menu
will select the entire body.
» As a shortcut, pressing Command-Down Arrow will move the cursor 
between the body and the envelope.

The FirstClass editor also supports:

• Styled text (including italics and bolding).
• Multiple fonts.
• Different sizes.
• Colored text.
• Command key equivalents for common styles and colors.

Once you have entered your message, you can select text and change it 
by choosing either the Font, Size, Style, or Color sub-menus from the 
Edit menu, and then choosing the appropriate item.
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Remember that fonts are installed in each Macintosh. If you use custom
fonts, the readers of your message must have the same fonts installed 
in order to see them. If FirstClass cannot find the font, it will use a 
default font. In order to avoid this problem, you may wish to use the 
standard system fonts (Geneva, Monaco, Courier, Helvetica and Times 
are fonts installed on most Macintoshes).

Note: Not all FirstClass Client applications are able to display styled 
and colored text. On some platforms all text is displayed in a 
single color and style. You should be careful while composing 
your message that it will be readable even in plain text.

While editing in FirstClass, your text is saved to the server as you type. 
If there is a problem (such as a communications failure or a power 
failure), the message will be preserved in your Mailbox on the server, 
and will be ready to send when you reconnect.

Sending Messages
Once you are ready to send a message, choose Send from the Message 
menu. If you close the message without sending it, FirstClass gives you 
the following options:

Click the Send Now button to send the message. If you don’t want to 
send the message (perhaps you want to work on the message later), 
click the Don’t Send button and the message will be kept in your 
mailbox with an unsent flag beside it. Clicking the Cancel button will 
allow you to continue editing the message.

FirstClass Client for Macintosh - Getting Started



When a message is sent, a Postmark is automatically stamped on the 
top right portion of the message. The postmark indicates that the 
server has received the message and has begun delivery to the 
recipients:

Replying To Messages
You can respond to any message by replying to it. When you have a 
message open or selected and you choose Reply from the Message 
menu, FirstClass automatically creates a new message with the From, 
Subject, To, and Cc lists filled in. “Re:” is automatically inserted before 
the original subject. The original sender is entered in the To field, and 
copies are sent to anyone who received the original message (you may 
delete names from the To and Cc lists by clicking on the name and 
pressing the Delete key).

For example, here is a message and the reply generated by choosing 
Reply from the Message menu. Note that the From, Subject and To lists 
are filled in automatically:
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Once you have entered the body of the new message, you may send it.

Forwarding Messages
You may re-send any message to another user using the forward 
feature. When you have a message open or selected and you choose 
Forward from the Message menu, FirstClass automatically creates a 
new message which is a copy of the selected message (including 
attachments) with the From and Subject fields filled in. “Fwd:” is 
automatically inserted before the original subject.
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For example, here is a message and the forwarded message generated 
by choosing Forward from the Message menu. Note that the subject 
has been filled in and the body had been copied from the original to the
forwarded message. Also, note that the From field lists the original 
sender as well as the name of the person who forwarded the message:

Once you have entered the recipients of the new message, you may edit
the body and send it:
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Sending Forms
In addition to supporting standard office-memo style messages, 
FirstClass also supports electronic forms. You can compose and send 
forms as with normal messages, but the forms may contain fill-in fields, 
checkboxes, popups, etc.. Each FirstClass system includes several 
standardized forms to choose from, including File Transfer, Phone Call, 
Request For Information, and a Requisition Form.

To send a form, choose New Form from the Message menu, then select 
the form you wish to send from the sub-menu. For example, to send a 
new phone message form you would choose Phone Message from the 
New Form menu:
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This would create a new Phone Message form, which you fill in, address
and send as you would any message:
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Keeping Your Mailbox Tidy
To keep your Mailbox tidy FirstClass allows you to file messages in 
folders and to delete unwanted messages.

Using Folders
To clean up your Mailbox, you might want to organize some of the 
messages so that you can refer to them later on. FirstClass allows you 
to create folders in your Mailbox  for this purpose.

To create a folder in your Mailbox, open your Mailbox and choose New 
Folder from the Conference menu. A new folder will be created in the 
upper pane of the current window. To rename the folder, click on the 
name and then type in the new name.

You can create multiple folders in your Mailbox and also folders within 
folders. To place messages into folders, simply drag them into the 
folder using the mouse. You can also shift-click to select multiple 
messages and drag all of them into the appropriate folder.
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Deleting Messages
If you receive many mail messages, your Mailbox can quickly become 
cluttered. To delete messages from your Mailbox, select the messages 
you want deleted (shift-click to select multiple messages) and choose 
Delete from the File menu.

Before actually deleting the messages, FirstClass will ask you to verify 
that you want to delete the selected items. Click Delete to delete 
selected items, or Cancel to cancel the delete. Regular deletion of old 
messages is recommended in the interests of conserving disk space on 
the server. You can delete folders in exactly the same way you delete 
messages: highlight the folders and choose Delete from the File menu.

Note that FirstClass will not actually delete an message from disk until 
all recipients have deleted it. This means that you may delete items you
have sent without worrying about them being deleted from the 
recipient’s Mailboxes.

Message Expiry
All messages in FirstClass have an expiry date, after which they will be 
automatically deleted. You may see the expiry date of a message by 
selecting or opening the message and then choosing Get Info from the 
File menu. The expiry date in your Mailbox and each conference is set 
by your Administrator.
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Conferencing

Conferences are forums or bulletin boards which are generally focused 
on a single topic. For example, there might be a conference that 
contains items dealing with a particular type of software, or a specific 
product, or a topic of interest. By reading these conference items, you 
can stay abreast of information you are interested in.

Opening the “Conferences” icon on the desktop displays the contents of
the “Conferences” Folder. In this folder you will find all of the public 
conferences that are available on your system.

♦ A Note about available conferences... The specific list of conferences 
available on your system will depend on the special interest 
groups within your user community. If you feel there is a need 
for a conference your server does not have, your Administrator 
can create a new one for you.

If you are interested in a conference, open it by double-clicking on its 
icon. FirstClass shows you which conferences contain items that you 
have not yet read by putting an unread flag beside the icon.
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♦ A Note about conference information... If you are curious about the 
contents of a specific conference, you can select the conference 
and choose About Conference... from the Conference menu. This
displays a window that contains a brief description of the 
conference. You may also double-click on the name of a 
conference in any message to display this information.

Browsing Conferences
When you open a conference, a summary of the messages in the 
conference is displayed.

 

The conference summary is just like the display in your Mailbox. Items 
that you have not yet read are marked with an unread flag ( ) and any
that have attachments are marked with an attachment flag ( ).  
» See the chapter entitled File Attachments and Transfers for more 
details on attachments.
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You may open any message in a conference by double-clicking on it, just
as you can do with messages in your Mailbox. The message will be 
displayed in a new window. To close the message, just click on the 
Close Box. You may continue to read messages in the conference until 
you have read all of the unread messages. When there are no more 
unread messages, the Unread Flag beside the conference icon will 
disappear.

Opening the Next Unread Message
Usually, you will want to read all of  the unread messages in a 
conference. To make this more convenient, FirstClass provides a 
shortcut to do this: simply open the conference and then choose Open 
Unread from the Conference menu. FirstClass will open the next 
unread message in the conference. Continuing to choose this menu 
items will read all unread messages. When there are no more unread 
messages, FirstClass will beep to inform you.

Since this is a common operation, you might also find it convenient to 
use either the keyboard equivalent (Command-U) or the palette button: 

Replying To Messages
As you are browsing through a conference, you might see a message 
that you wish to respond to. This is easy to do – you just open or select 
the message and then choose Reply from the Message menu. FirstClass
will create a new, unsent message in your Mailbox with the From, 
Subject, and To fields filled in appropriately. You then click in the body of
the message and enter your reply. When you send the message, it is 
delivered to the conference.
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Replying To The Sender of a Message
When you are in a conference and you choose Reply, the To: list of the 
reply normally contains the name of the conference you are in. If you 
want to reply to the sender of the message rather than the conference, 
choose Reply Sender from the Reply Special sub-menu (in the Message 
menu).

Following Message Threads
As users discuss various topics in a conference, the original message 
and the set of replies creates a thread of messages on a particular 
topic. For example, in the following conference there are several 
messages all on the topic of “My CD Adapter”:
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Next In Thread
If you open the initial message (e.g. the one from Colin Biggin) and 
then choose Next in Thread from the Conference menu, FirstClass will 
open the next message in the thread, in this case the message from 
Colin Welch. Choosing Next in Thread again will open then next 
message (from Colin Welch), and choosing it again will open the 
message from Jane. If you choose Next in Thread again and there are 
no more messages in the thread, FirstClass will notify you with a beep. 
Since this is a common operation, you might also find it convenient to 
use either the keyboard equivalent (Command-/) or the palette button:  
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Previous In Thread
The threading feature will also work in reverse, to take you to the 
previous message in the thread. This is especially useful when you read
a message in the middle of a thread, but the message does not have 
enough information to give you the context.

In the example above, suppose you opened the last message in the 
thread, from Jane Jazrawy. To open the previous message in the thread, 
hold down the Option key before pulling down the Conference menu 
and choosing Next in Thread. 

Since this is a common operation, you might also find it convenient to 
use either the keyboard equivalent (Command-Option-/) or the palette 
button:   

Sending Messages To Conferences
To send a new message to a conference, simply open the conference 
and then choose New from the Message menu. A new, unsent message 
will be created in your Mailbox, with the To name already filled in with 
the conference name.

For example, if you opened the “Customer Support” conference and 
chose New, the following unsent message would open on your screen. 
Note that it is pre-addressed to “Customer Support”
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After you have entered the subject and the body of the message, send 
the message and it will be delivered to the conference:

Forwarding Messages
You may forward conference messages to other users or conferences. 
Simply open or select the message you want to forward and then 
choose Forward from the Message menu. FirstClass will duplicate the 
contents of the message, including attachments. The new message has 
an empty envelope. After you fill in the envelope information you may 
edit the body text and then send it.
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Subscribing to a Conference
If you use a particular conference frequently you may wish to subscribe
to it, which places an alias of the conference onto your desktop. 
Subscribing to a conference is a simple way of keeping a watch on the 
conferences that are of the most interest to you. Instead of navigating 
through various conferences and sub-conferences, you can just double-
click on the alias on your desktop, which will open the conference.

If there are unread items in the conference, the unread flag is displayed
next to the alias, which makes it easier to find new items. Rather than 
having to go and look at each conference individually, by subscribing 
you will be able to tell at a glance which conferences have new 
messages.  

To make an alias to a conference, click on the conference and then 
choose Make Alias from the Conference menu. An alias of the 
conference will appear on your Desktop.

Here is an example: The “Customer Support” conference on the Veritec
BBS system is in the “Conferences” folder. If you are interested in the 
“Customer Support” conference, it is much more convenient to have an 
alias of the conference right on your Desktop than to manually open 
layers of conferences. To do this, click on the “Customer Support” 
conference and then choose Make Alias from the Conference menu. An 
alias of the conference will appear on your desktop:

In this example, the conference has an unread flag to indicate that the 
conference contains some new items. You may also delete an alias from 
your Desktop by selecting the alias and choosing Delete from the File 
menu. Deleting the alias will have no effect on the conference itself.
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Private Conferences
Your Administrator might have designated certain conferences as 
private. If you have access to any private conferences, their icons will 
also appear on your desktop or in a special folder.
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Attachments and File Transfers

FirstClass allows you to transfer or share files with other users using 
the attachment feature.  When you compose a message, you can attach 
any file stored in your computer to the message. You then send the 
message as usual. When you read a message with attachments, you can
transfer any of the attachments to your computer. A powerful feature of
FirstClass is that attachments work well with both private mail and 
conferences. This means that you can easily distribute files to large 
numbers of users.

Since you are using FirstClass to transfer the files, there is no need to 
worry about the type of file you are transferring or what type of file 
transfer is being used – you just attach the file. FirstClass file transfers 
work just the same whether you are connected over a modem or a 
network, and they even work if the recipient is on another type of 
computer, such as a Windows computer.

Background File Transfers
When you are transferring a file from your Macintosh to the FirstClass 
server or transferring a file from the server to your Macintosh, 
FirstClass performs the transfers in the background. This means that 
even while a file transfer is in progress, you may continue to use all 
features of FirstClass, even if you are connected over a modem.

Reading Messages With Attachments
If a message has any attached files an attachment icon ( ) will be 
displayed beside the message in the summary list and an Attachments 
list appears in the envelope. For example, the “Customer Support” 
conference might have the following message in it. Note that there are 
two files attached to the message:
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To save an attachment on your Macintosh, select it and then choose 
Save Attachment from the File men (as a shortcut, you may also double-
click on the attachment). A dialog will come up and allow you to choose
the destination folder and filename on your Macintosh (the standard 
folder is the “Download” folder inside the “FirstClass Client 2.5” 
folder). Click Save and the file transfer from the server to your 
computer will begin. Note that he time required for the transfer varies 
depending on the size of the file and the speed of your connection:

The File Transfer Progress window displays the status of the file 
transfer. When the transfer is complete, this window disappears. (Note 
that you can move this window by dragging it). Closing this window will
cancel the file transfer. Remember, You can continue to use all of the 
features of FirstClass even while a file transfer is in progress. If you 
cancel a file transfer before it is finished, you can restart the transfer 
by downloading to the same file and choosing Replace. Only the 
remaining data will be transferred.
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Sending Messages With Attachments
To send a file to another user or a conference, compose a new message 
as usual. To add an attachment to the unsent message, choose Attach 
from the File menu. You will be prompted to select the file that you 
want to attach.  Select the file you want to attach and then click on the 
Attach button to transfer the file from your computer to the server. The 
time required for the transfer will vary depending on the size of the file 
and the speed of your connection.

While the file is being transferred, the File Transfer Progress window is
displayed. You can continue to use all of the features of FirstClass even 
while the file transfer is in progress. When the transfer completes, the 
attachment will be listed in the envelope of the message. You can attach
as many files as you wish. If you make a mistake, you can delete an 
attachment by selecting it and then pressing the Delete key.

If you are sending attachments that will be downloaded by users logged
on with modems, or if you are using a modem, you should consider 
using a compression utility such as Compactor™, Stuffit™, or 
DiskDoubler™.  Compressing files will allow them to be sent faster, 
thereby reducing the duration of your phone calls.

Viewing Attachments
If the attachment is a picture, text file, or sound you can view it online 
by selecting it, holding down the Option key, and choosing View 
Attachment from the File menu (or just holding down the Option key 
and double-clicking on it). The attachment displays in a new window. 
You can then copy the attachment and save it on your computer.
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The “FirstClass Client 2.5” Folder

The FirstClass Client application exists inside the “FirstClass Client 
2.5” folder on your hard disk. After you have installed the FirstClass 
Client, the folder will look like this:

The folder contains the FirstClass Client 2.5 application, as well as a 
number of other files and folders that are required for FirstClass to run 
correctly.

Important The FirstClass Client 2.5 application must be in the same 
folder as the “Settings”, “Modems”, “FCP” and “Scripts” 
folders. If you move the client to another folder, you will 
be unable to successfully run FirstClass.
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The “Settings” Folder
The “settings” Folder contains all of the FirstClass Settings Documents 
supplied with the FirstClass Client. Each Settings Document contains 
the information required to connect to a particular FirstClass Server, 
such as the phone number or network name. The Settings Documents 
also contain any custom forms, sounds, icons and pictures that the 
Administrator has supplied. Finally, the Settings Document contains the
name of the Connection File that will be used to make the connection to
the FirstClass server.

If you want to call a system for which you have no Settings Document, 
you may duplicate the “Generic Modem” or “Generic Network” file and 
rename the duplicate.

The “FCP” Folder
In order to use FirstClass, the FirstClass Client must make a connection
to the FirstClass Server. This connection may be made in a number of 
ways, including modem, AppleTalk, etc.

Every possible connection type is controlled by a Connection File. The 
“FCP” folder is a collection of Connection Files for most of the common 
connection types. Each file is named with the name of the connection 
followed by “.FCP”. When you initially install a Settings Document, you 
should choose the connection method you will use by choosing the 
appropriate Connection File from the Connect Via popup on the Settings 
Form. 

Editing Connection Files
To edit a Connection File, select it using the Connect Via popup and then
click on the Setup button. The basic Connection Setup Form will be 
displayed, with additional fields based on the actual connection 
protocol. 
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The name of the Connection File being edited is displayed at the top of 
the form. The Cancel button will close form without saving changes to 
Connection File, while the Save button will close form and save 
changes to FCP file.

Remember that the Connection File will be opened and used for all 
Settings Documents which are set to use that connection. For example, 
if you change the “Modem.FCP” Connection File to turn off the speaker,
then the speaker will be off for all Settings Documents which use 
“Modem.FCP”. If you need to have two different connection settings 
then you will need to create an additional Connection File and set it up 
appropriately. For example, you might want the speaker on for some 
systems and off for others, in which case you would duplicate 
“Modem.FCP”, rename it “Quiet Modem.FCP”, turn the speaker off in 
“Quite Modem.FCP”, and then select the appropriate Connection File in
each Settings Document (“Quiet Modem” or “Modem”).

The Connection Setup Form looks like this:
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Protocol
The Protocol popup allows you to choose the actual 
communication method that this Connection File will instruct 
FirstClass to  use to connect to the server. Choices are

AppleTalk
Use the AppleTalk network to access the server.

Comm Toolbox
Use the Communication Toolbox to access the FirstClass Server.

Serial
Use a serial port to access the FirstClass Server.

Comm Toolbox Serial
Use a serial connection to access the FirstClass Server, but use 
the Communication Toolbox to access the serial port. You should
only use this if the standard serial port access is unavailable.

Setup CommToolbox button (optional)
This is displayed only when Protocol is set to Comm Toolbox or Comm 
Toolbox Serial. When clicked it will display the Communication Toolbox 
Setup Form for the tools you have installed. For more details, see the 
documentation that accompanied your Comm Toolbox Tools.

Connection 
The Connection area on the form is displayed only when Protocol is set 
to Serial or Comm Toolbox Serial:

Modem
Allows you to choose the Modem File for the modem you will be using. 
This popup will list all available modem settings (from the “Modems” 
folder).

FirstClass Client for Macintosh - Getting Started



Port
Allows you to choose which serial port you will be using. This is not 
displayed when Protocol is set to Comm Toolbox Serial, because in that 
case you use the Comm Toolbox to select the serial port.
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Phone
Allows you to choose between Tone and Pulse dial.

Speaker
Allows you to choose between modem speaker on or off.

Script
Each Connection File may have an associated script file. Normally this 
should be left at “-”. For details, see the section on scripts later in this 
chapter.

Cable Options
The Cable Options section allows you to describe what kind of cable 
you have connecting your Macintosh and your modem. The Cable 
Options area on the form is displayed only when Protocol is set to Serial 
or Comm Toolbox Serial.

H/W Handshake
When you are using a modem with either compression or error 
correction, the Macintosh is able to send information to the modem 
faster than the modem is capable of sending it. For example, if there is 
an error in transmission the modem will have to retransmit the data, 
and while the retransmission is in progress the modem needs to tell the
Macintosh to stop sending data. This process of informing the 
Macintosh to stop and start sending data is called handshaking.

There are two types of handshaking, hardware handshaking (also called
RTS/CTS) and software handshaking (also called XON/XOFF). Software
handshaking cannot be used with FirstClass. In order to use 
Hardware Handshaking, you must have a special cable that connects 
the hardware handshaking pin on the Macintosh to the hardware 
handshaking pin on the modem (this is called a Hardware Handshaking
Cable). 
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Turning this checkbox on will instruct the Macintosh to use hardware 
handshaking, and it will also send the appropriate option commands to 
the modem to instruct it to use hardware handshaking. If you turn this 
checkbox on and you do not have a Hardware Handshaking Cable, 
FirstClass will tell you that it is unable to get a response from the 
modem, because it will never receive the handshaking signal from the 
modem.

DTR Hangup
Normally, when you log off of the server while using a modem 
FirstClass hangs up the modem by sending the Attention command to 
the modem followed by the Hangup command. A faster way to hangup 
the modem is to use the DTR pin on the modem. If you have a 
Hardware Handshaking Cable, you may turn on this checkbox. This will
instruct your Macintosh to use the DTR pin to hang the modem up, and 
it will also send the appropriate option command to the modem to 
instruct it to monitor the DTR pin. If you turn on this checkbox and you 
do not have a Hardware Handshaking Cable, FirstClass will continue to
use the Hangup Command.

Carrier Detect
Normally, your Macintosh has no way of knowing whether the modem is
connected to the server. FirstClass simply sends out commands and 
waits for a response from the server. If FirstClass gets no response 
from the server, it knows that the modem is no longer connected.

Although this method works, it is slow to detect a dropped connection. 
You may enable a faster for of detection by using the Carrier Detection 
feature in your modem. When this feature is enabled, the modem will 
turn on the Carrier Detect pin to inform the Macintosh that it is 
connected to the server. If the connection is dropped for any reason, 
the server will turn the pin off.

In order to use this feature, you must have a Hardware Handshaking 
Cable, and you must have a Macintosh that supports the Carrier Detect 
pin. All Macintosh II and most Quadras support this pin. When this box 
is checked, FirstClass instruct your Macintosh to monitor the Carrier 
Detect pin, and it will also send the appropriate option command to the 
modem to instruct it to enable the Carrier Detection feature. If you turn
on this checkbox and you do not have a Hardware Handshaking Cable, 
FirstClass will continue to use timeouts to detect loss of connection.
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Hardware Handshaking Cables
Most modern modems come with proper Hardware Handshaking 
Cables, and they are also available from SoftArc. Your modem cable 
should have the following internal connections:

Speed Options
Auto Speed

If this is On, FirstClass will set the serial port speed to match 
the speed reported in the “CONNECT” report from the modem. 
If this is Off, FirstClass will ignore the speed in the “CONNECT” 
report. For example, if Auto Speed is On and the modem reports 
“CONNECT 2400”, FirstClass will set the serial port speed to 
2400 baud. If AutoSpeed is off,. FirstClass will leave the serial 
port speed unchanged. The setting of this popup is 
determined by the modem type. Do not change this 
without referring to your modem documentation.
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Baud Rate
The baud rate that FirstClass will use when initially talking to 
the modem . The setting of this popup is determined by the 
modem type. Do not change this without referring to your 
modem documentation.

Advanced Settings
Click on the triangle to access advanced connection settings. These 
settings are designed for experienced users only.

Trace
Checking any of the Trace options will instruct FirstClass to 
save the specified actions in the “FCClient.log” file.

Receive
Trace all received packets.

Send
Trace all sent packets.

Errors
Trace all packet errors.

Connect
Trace all connection messages.

Modem/Scripts
Trace all modem and scripting commands.
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Window
FirstClass uses a sliding window protocol, which allows for efficient 
data transfer even over long connection paths. If you are connected 
over a line with long delays (e.g. Wide Area Network, satellite link) you 
should set this to 8. If you are connected over a very slow link with 
little or no delay (e.g. 2400 baud modem connection) you should set 
this to 4.

Packets
This popup allows you to set the maximum packet size. Larger packets 
are more efficient, but will slow down response to other commands 
while file transfers are in progress. It is recommended that you use 232
byte packets for 2400 baud modems and 512 byte packets for 9600 and
14,400 baud modems and networks. If this is set to Auto FirstClass will 
select the size based on the modem speed.

Lock
Normally, when FirstClass encounters errors in transmission it will 
shorten the size of the packets. If this popup is set the packets will be 
locked at the size specified.

Encrypt
If this is set then FirstClass will encrypt all data being passed between 
the client and server. In general, this is only required on networks. In 
addition, modems will be unable to compress encrypted data, so this 
should not be turned on if you are using a V.42bis (compression) 
modem connection.

The “Download” Folder
When you transfer a file from the FirstClass Server to your Macintosh, 
FirstClass will ask you where on your Macintosh you want the file 
saved. The standard choice is to place the file in this folder.
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The “Modems” Folder 
Every modem is controlled by sending it a series of commands, but 
almost all modems use slightly different commands. The “Modems” 
folder is a collection of command files for most of the popular modems. 
Each file (called a Modem File) is named with the name of the modem 
followed by “.MDM”. When you set up the Modem Connection File 
(“Modem.FCP”), you must select your modem from the list.

Content of the Modem Files
Each Modem File consists of a list of command keywords followed by 
the actual commands for the particular modem defined by the file. For 
example, the Hayes Accura Modem File (“Hayes Accura.MDM”) looks 
like this:

FirstClass Client for Macintosh - Getting Started



Each non-numeric command must be surrounded by quotes, and all 
occurrences of “\r” are replaced with a Return.

The command keywords are:

MNAME
The modem name.

MDMATT
The Attention command. Sent to the modem to place it into 
command mode.
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MDMDIAL
The dial command. Sent to the modem when a number is dialed. 
The “%s” is replaced by the number being dialed.

MDMTONE
The dial modifier for Touch Tone dialing. This command is 
placed at the beginning of the number being dialed before the 
number is placed into the MDMDIAL command.

MDMPULSE
The dial modifier for pulse (rotary) dialing. This command is 
placed at the beginning of the number being dialed before the 
number is placed into the MDMDIAL command.

MDMHUP
The hangup command. Sent to the modem to force it to hang up.

MDMANS
The answer command.

MLTO
Long Timeout, in 1/60th of a second intervals. The amount of 
time the modem will wait between starting to dial a number and 
receiving a response.

MSTO
Short Timeout, in 1/60th of a second intervals. The amount of 
time FirstClass will wait between sending a command and 
receiving “OK” back from the modem. If FirstClass does not 
receive an “OK” within this time, it will display a timeout error.

MDMRESET
The modem reset command. Sent to the modem at the beginning
of every login. The reset should perform the basic modem 
configuration.

FirstClass Client for Macintosh - Getting Started



MDMINIT
The modem initialization command. Sent to the modem 
immediately following the reset command. This command should
perform additional modem configuration.

MDMOPT
The modem options command. Depending on the checkboxes on 
the Connection Setup Form, the “%s” will be replaced with the 
following values:

MDMHWHS
Hardware Handshaking command. Sent to the modem to 
instruct it to use hardware handshaking. If H/W Handshake is On, 
this will be added to the “%s” in the MDMOPT command.

MDMSPKR
Speaker On command. Sent to the modem to instruct it to turn 
on the speaker. If Speaker is On, this will be added to the “%s” in 
the MDMOPT command.

MDMDCD
Carrier Detection command. Sent to the modem to enable the 
Carrier Detect pin. If Carrier Detect is On, this will be added to 
the “%s” in the MDMOPT command.

MDMDTR
DTR Hangup Command. Sent to the modem to enable DTR 
Hangup. If DTR Hangup is On, this will be added to the “%s” in 
the MDMOPT command.

MBAUD
The baud rate that FirstClass will use when initially talking to 
the modem when the H/W Handshake popup is Off.

MHWHSBAUD
The baud rate that FirstClass will use when initially talking to 
the modem when the H/W Handshake popup is On.
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MAUTOSPEED
If this is set to 1, FirstClass will set the serial port speed to 
match the speed reported in the “CONNECT” report from the 
modem. If this is 0, FirstClass will ignore the speed in the 
“CONNECT” report. For example, if AutoSpeed is On and the 
modem reports “CONNECT 2400”, FirstClass will set the serial 
port speed to 2400 baud. If AutoSpeed is off, FirstClass will 
leave the serial port speed unchanged.

MCOMMENTS
Comments on the modem. Displayed on the Connection Setup 
Form when the modem is selected.

Adding New Modems
If you receive additional Modem Files, you need only drop them in the 
“Modems” folder and they will immediately appear in the Modem popup 
on the Connection Setup Form.

You may also create your own new Modem Files by duplicating an 
existing file, renaming it, and using the manual that accompanied your 
modem to enter the commands correctly.

The “Scripts” Folder
Each Connection File may have an optional script associated with it. 
The script will be executed after the standard FirstClass modem 
handling has run. The Script Files are stored in the “Scripts” folder and
all end in “.FCL”.

Remember that the name of the script in use is stored on the 
Connection File, so selecting a script will instruct FirstClass to use the 
script in all Settings documents that use that Connection File.
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The “FCClient.log” File
A new “FCClient.log” file is created whenever the FirstClass Client 
application is run, and contains log information. To control what 
information goes into the log file, use the Trace checkboxes in the 
Advanced Settings section of the Communication Setup Form.

The “Read Me” File
The “Read Me” file is included to document any changes to the 
operation of FirstClass since this manual was printed. You should read 
it after installing FirstClass.

The “About Modems” File
The “About Modems” file contains additional information about modems
that may have changed since this manual was printed. You should read 
it if you will be using a modem to connect to the FirstClass Server.

FirstClass Client for Macintosh - Getting Started



FirstClass Client Menus

This chapter provides an overview of each of the menu items available 
in the FirstClass Client application.

The File Menu
New
Create a new message. If you choose New before you are logged on it 
will create a new Settings Document.

Open
Open the selected item. You may also double-click on an item to select 
and open it in a single step.

Close
Close the current window. You may also click on the close box in the 
upper left corner of the window to close it.

Save
Save the current item on your hard disk. There is no need to save 
messages as they are automatically saved on the FirstClass server.

Upload/Attach File
Transfer a file from your Macintosh to the FirstClass server. If the 
current window is a message, this menu item will be Attach File. If the 
current window is a conference or folder for which you have Upload 
permissions, the menu item will be Upload. If you do not have Upload 
permissions, this menu item will be grayed out.
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Download/Save Attachment
Transfer a file from the FirstClass server to your Macintosh. If the 
current window is a message, this menu item will be Save Attachment. 
If the current window is a conference or folder for which you have 
Download permissions, the menu item will be Download. If you do not 
have Download permissions, this menu item will be grayed out.

Delete
Delete the current item or any selected items. This menu item will be 
grayed out if you do note have Delete permissions.

Get Info
Display additional information about the current item or any selected 
items.

Search
Search the current window for information. This will be grayed out if 
you do not have the Search permissions.

Search Next
Find the next item matching the current search specifications

Page Setup
Set up the printer characteristics.

Print
Print the current window.

Quit
Exit from the FirstClass application. If you are connected via modem, 
FirstClass will confirm that you want to quit.
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The Edit Menu
Undo
Not implemented in this version.

Cut
Delete the selected information and place it on the clipboard.

Copy
Place the selected information on the clipboard.

Paste
Insert the information on the clipboard.

Clear
Delete the selected information.

Select All
Select everything in the current window.

Font
Set the font of the selected text.

Size
Set the size of the selected text.

Style
Set the style of the selected text.

Colour
Set the colour of the selected text.
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Preferences
Display the Preferences Form:

Résumé
Display your résumé. Your résumé will be displayed whenever someone 
double-clicks on your name. You should enter any information you want.
You may also paste a picture into the box in the upper-left corner:
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The Message Menu
Compose
Create a new message. If you choose this menu item in a conference for
which you have Send permissions, the message will be automatically 
addressed to the conference.

New Form
Create a new message form. If you choose this menu item in a 
conference for which you have Send permissions, the message will be 
automatically addressed to the conference.

Reply
Create a message as a reply of the current message or any messages 
selected in current window. Replies to messages in your mailbox will be
addressed to all recipients, while replies to messages in conferences 
will be addressed to that conference only. You may also choose to reply 
to selected addressees using the Reply Special command.

Reply Special
Reply All
Address the reply to all recipients of the original message.

Reply Sender
Address the reply only to the sender of the original message.

Reply Conference
Reply only to the conferences in the address of the original message.

Forward
Create a message which is an exact copy of the current message or any
messages selected in current window. You may the address and send 
the new message. If you do not have the Forward privilege this menu 
item will be grayed out.
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Send
Send the current message. This will be grayed out of the current item is
not a message or if the current item has already been sent.

Unsend
Retract the open or selected message. If you do not have the Unsend 
privilege this menu item will be grayed out.

History
Display the history form for the open or selected message. If you do not
have the View History permission this menu item will be grayed out.

Unread
Toggle the Unread Flag on the open message or the selected messages 
in the current window. You are only able to do this if you have the Make
Read privilege.

Priority
Set the priority of the open message. The priority is used to control the 
behavior of mail sent through gateways as well as the display of the 
message in the recipient’s mailbox. Possible priorities are:

Normal
This is the standard setting.

Urgent
Display the message subject in bold and use special gateway handling.

Bulk
Used for some gateways. See your gateway documentation.

Sensitivity
Used for some gateways. See your gateway documentation.
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Receipt
Turning receipting on will automatically generate receipt messages 
when certain events happen. Receipting options are:

On Read
Generate a receipt when the recipient reads the message.

On Delivery
Generate a receipt when the message is delivered to the recipient 
(useful when the recipient is on another server).

On Route
Generate a receipt in each stage of the delivery of multi-hop mail. 
Useful for detecting problems is multi-server mail systems.

Suppress NDN
Stop this message from generating Non-Deliverable Notices (NDNs).

The Conference Menu
Open Unread
Open the next unread item in the current window.

Next in Thread
Open the next message in the current thread.

New Conference
Create a new conference. If you do not have the Create Conference 
permissions this menu item will be grayed out.

New Folder
Create a new folder in the current window.
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Make Alias
Make an alias of the currently selected conference and place the alias 
on the FirstClass Desktop.

Permissions
Display the Permissions Form of the currently open or selected 
conference. If you do not have the Display Conference Permission 
permission this menu item will be grayed out.

Approve
Approve the selected or current message. If you do not have the 
Approver permission this menu item will be grayed out.

About Conference
Display information about the selected or current conference.

The Service Menu
Connect/Disconnect
If you are not connected to a FirstClass Server, choosing this menu 
item will initiate a connection using the connection method you have 
chosen. If you are already connected, choosing this menu item will 
disconnect you from the FirstClass Server.

Setup
Choosing this menu item will display the Settings Form for the Settings 
Document you have open.

Connection Setup
Choosing a connection type from this sub-menu item will display the 
Connection Setup Form for that Connection File.
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Directory
Choosing this menu item will display a window that allows you to 
display names in the FirstClass System Directory.

Who’s Online
Display a list of all users logged on to the FirstClass Server.

Private Chat
Initiate a private chat with one or more users. Once the Chat Window is
open, you may invite other users into the chat using the Invite button.

Change Password
Change your password.

The View Menu
by Icon
Display entries in the current window using icons.

by Date
Display entries in the current window as a list sorted in date order, with
the oldest item at the top.

by Name
Display entries in the current window as a list sorted in alphabetical 
order of the sender’s name.

by Subject
Display entries in the current window as a list sorted in alphabetical 
order of the subject.

FirstClass Client for Macintosh - Getting Started



by Size
Display entries in the current window as a list sorted in order of the 
increasing size.

by Status
Display entries in the current window as a list. Outgoing messages will 
be displayed at the top, incoming at the bottom. Within each set of 
messages, urgent messages will be displayed at the bottom, and within 
these divisions messages will be displayed by date.

Reverse Sort
Change all of the above sort orders to the reverse order. Dates will be 
displayed with the latest message first, alphabetic will be displayed 
starting with “z”, size will be displayed with the largest first, and status
will be displayed with the newest urgent messages at the top.

Clean Up Icons
Arrange the selected icons on a grid in the current window.

Zoom
Expand the current window to uncover all icons.

Tile
Make all open windows the same size and tile them on the available 
screen.

Stack
Stack all of the windows in the upper-left corner of the screen.

Session Status
Display the session status window:

FirstClass Client for Macintosh - Getting Started



Palette
Display the palette.

Desktop
Make the FirstClass Desktop the current window.
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About Conference 78

About Modems file 69
Active button 21
Addressing 31
Administrator 2, 3, 9
Advanced Settings 62
Aliases 49
alt.bbs.first-class 4
America Online 4
Apple Menu 21
AppleLink 4
AppleTalk 2, 21, 58
Approve 78
Attach File 71
Attachment Flag 44
Attachment Icon 51
Attachments

About 51
Saving 52
Sending 53

Attachments List 51
Auto Speed 15, 61
Auto-Registering 11
Automatic Deletion 41
Automatic Login 17, 23
Background File Transfers 51
Baud Rate 15, 62
Bold Messages 30
Bulk 76
Busy 20
Busy Retry 17
Buttons 3
by Date 79
by Icon 79
by Name 79
by Size 80
by Status 80
by Subject 79
Cable, modem 13, 15
Cables 61

Modems 59

Cancel button 11, 18, 23
Carrier Detect 60
Change Password 79
Changing Password 11
Choose 2
Chooser 21
Clean Up Icons 80
Clear 73
Client 2
Close 71
Color 33
Colour 73
Comm Toolbox 58
Comm Toolbox Serial 58
Commands, Modem 19
Communication Methods 2
Compose 75
Composing Mail 31
Compression 63
Compuserve 4
Conference

Summary Window 44
Conference Menu 77
Conferences 25

About 43
Browsing 44
Private 50
Sending Messages 47
Subscribing 49

Connect 62, 78
CONNECT from modem 19
Connect Via 22
Connect via popup 15, 16
Connected 20
Connection Files 56
Connection Setup 78
Connection Setup Form 14, 19, 57
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Conventions, documentation 3
Copy 73
Cursor 26
Cut 73
Delete 72
Deleting Messages 41
Desktop 49, 81
Dial Command 19
Dial phones 15
Directory 31, 79
Directory Window 32
Disconnect 78
Disk Space 5
Diskette 6
Double-click 2
Download 52, 72
Download Folder 63
Drag 2
DTR Hangup 60
Duplicate 10
Edit Menu 73
Editor 33
Encrypt 63
Encryption 63
Error 1044 24
Errors 62
Ethernet 2
Expiry 41
FCClient.log 69
FCL Files 68
FCP Folder 56
File 2
File Menu 71
File Transfer Progress 52
File Transfers 51
FirstClass

Desktop 20
Installing 5
Installing from archive 7
Installing from diskette 6
Logging In 9
Login using modem 18

Manuals 3
Modem commands 19
Support 3

FirstClass Client
About 2

FirstClass Client application
Starting 10

FirstClass Client folder 9
FirstClass Desktop 49
FirstClass Editor 33
FirstClass Server 9

About 2
On Network 24

Flags
Attachment 30
Unread 28, 30
Unsent 30

Folder
Modems 64

Folders
Download 63
FCP 56
In Mailbox 40
Naming 3
Scripts 68
Settings 56

Font 73
Fonts 33
Forms 9, 38
Forward 75
Forwarding 48
Forwarding Messages 36
Generic Modem 56
Generic Network 56
Get Info 41, 72
H/W Handshake 59
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Handshaking 13, 15, 59
Hard Disk 5
Hardware Handshaking 13, 15
Hardware Handshaking Cables 61
Help 25
History 76
Icons 9
Installation 6, 7
Installing FirstClass 5
Internet 4
Italics 3
Log Files 69
Login 10

via AppleTalk 24
Login button 11, 18
Login Form 10, 18
Logon Automatically 17
Macintosh

Disk Space 5
Mac Plus 5
Manuals 2
Memory Requirements 5
System Software 5
Terms 2
What Macs? 5

Mail
Addressing 31
Reading 29

Mailbox 25
Creating new messages 31
Opening 29
Using Folders 40

Make Alias 78
Manuals

FirstClass 3
Macintosh 2

MAUTOSPEED 68
MBAUD 67
MCOMMENTS 68
MDM Files 58, 64
MDMANS 66
MDMATT 65

MDMDCD 67
MDMDIAL 66
MDMDTR 67
MDMHUP 66
MDMHWHS 67
MDMINIT 67
MDMOPT 67
MDMPULSE 66
MDMRESET 66
MDMSPKR 67
MDMTONE 66
Memory Requirements 5
Message

Body 27
Envelope 27

Message Menu 75
Message Windows 27
Messages

Deleting 41
Editing 33
Expiry 41
Forwarding 36, 48
Replying 35, 45
Sending 34
Sending Forms 38
Sending to Conferences 47
Threading 46

MHWHSBAUD 67
MLTO 66
MNAME 65
Modem 58, 62

Cables 13, 15
Commands 19
CONNECT response 19
Connection Setup Form 19
Dial Command 19
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Options 60
Options Command 19
Phone Number 17
Reset Command 19
Setting up 13
Setup Command 19
Using to log in 18

Modem Connection File 13, 16
Modem File 58
Modem Files 64
Modem popup 15
Modem Port 15, 19
Modems 51

About Modems file 69
Adding 68
Cables 59, 61
Carrier Detect 60
Compression 63
DTR Hangup 60
Speed & Packet Size 63
Timeout 60
Use of 2

Modems Folder 58, 64
Mouse 2, 26
MSTO 66
Name 9
Names, entering in messages 31
Naming Folders 3
NDNs 77
Negotiating connection 20
Network 17, 23
Networks

Logging In 24
Networks, AppleTalk 21
New 71
New Conference 77
New Folder 77
New Form 75
New Message 31
News 25
Next in Thread 46, 77
Next Unread 30, 45

No Carrier 20
Normal 76
OK from modem 19
On Delivery 77
On Read 77
On Route 77
Open 2, 71
Open Unread 30, 45, 77
Option-Click 28
Options

Modem 60
Options Command 19
Packet Size 63
Packets 63
Page Setup 72
Palette 81
Panes 26, 27
Password 9, 11, 17, 23
Password, changing 11
Paste 73
Permissions 78
Phone 59
Phone Message Form 38
Phone Number 17
Phone Numbers 9
Phone popup 15
Pictures 9
Port 58
Port popup 15
Postmark 35
Power Mac 5
Preferences 74
Previous in Thread 47
Print 72
Printer Port 15, 19
Priority 76
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Private Chat 79
Private Conferences 50
Protocol 58
Pulse 15, 59
Quit 72
RAM Requirements 5
Read Me files 69
Reading Mail 29
Receipt 77
Receive 62
Reply 45, 75
Reply Special 75
Replying to Messages 35
Reset Command 19
Resizing Windows 27
Résumé 74
Retry 17
Retry Delay 17
Reverse Sort 80
RTS/CTS 59
Save 71
Save Attachment 72
Save button 18, 24
Saving Attachments 52
Script 59
Scripts 62
Scripts Folder 68
Search 72
Search Next 72
Security 17, 23
Select 2
Select All 73
Send 62, 76
Sending Messages 34
Sensitivity 76
Serial 58
Serial Ports 15
Server 2, 9, 17, 23
Server Name 9, 24
Server Zone 9, 24
Service 11
Service Menu 78

Session Status 80
Settings Document 11, 18, 22

Settings Form 16
Settings Documents

About 9
Creating 10
Generic 10
Location 56

Settings Folder 9, 56
Settings Form 16, 22
Setup 78
Setup button 11, 16, 17, 23
Setup Command 19
Setup CommToolbox button 58
Setup... 16
Size 73
Size, packet 63
Sliding Window Protocol 63
SoftArc Online 4
Sounds 9
Speaker 59
Split Bar 26
Stack 80
Status Lines 18
Style 73
Styled Text 33
Subscribing to Conferences 49
Summary Window 44
Summary Windows 26
Support 3
Supress NDN 77
System 7 5
System Software 5
Text Size 33
Threads

About 46
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Next in Thread 46
Previous in Thread 47

Tile 80
Tone 15, 59
Touch Tone phones 15
Trace 62
Trace Checkboxes 69
Transferring Files 51
Undo 73
Unread 76
Unread Flag 44
Unread Flags 28, 29
Unsend 76
Upload 53, 71
Urgent 76

User ID 9, 11, 17, 23
User Manual 3
V.42bis 63
View Menu 79
Who’s Online 79
Window 63
Windows

File Transfer Progress 52
Message 27
Resizing 27
Summary 26

Word Processor 33
XON/XOFF 59
Zone 9, 23
Zoom 80
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Notes for next version:

- Better contents in snaps
- Dallas’ headers

Revisions:
- R2:

- fixed View Attachment menu (was Message, should be File)
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